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Content

Find tag

Show connection
Module modes
Module list

Forcing a value
Floating image window
Reminder note

10 image
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KONGSBERG

Find Tag identification

Find Tag identification:

Right click in an empty space of a process image
In the Module menu in the top menu bar

Type a tag name or a part of a tag name in “Tag”
Use the Browse button or enter

All module tags containing the text string will be
listed

List sorted by PS followed by tag name within
each PS
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Previous Image

Next Image
5 Find Tag
[Tagname——————————
Tag: [11253 ~

[ Match case
™ Matchwhale tag
[~ Matchinitial tag segment

Edit view JESSIEM Operaton Took !

Parameter View.
Terminal View.

Lol
Close

Selecttag

PS047: 50Y-112631
PS047: S0V-112632
PS047: 50Y-112533

3
PS047: S0V-112637
PS047: S0-112630
PS047: S0-112638_5D
PS047: 50Y-112539

[Right-click on tag ta getmadule context menu
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Find Tag dialog box

KONGSBERG

. _ _
—L 1 $B° Find Tag _lolx
Match case: e " -l
oy —I m Tag: (11253 hd &I
= Upper/lower case sensitive | 50 b -

B I Match case
™ Matchwhole tag

I™ Match initial tag segment

Match whole tag:

rSelecttag
= Whole tag name to be written
Ixm 8 PS047: 50Y-112533
PS047: S0V-112535
st PS047: S0V-112536 Operate,
Match initial tag segment: Psé7 0w 10537

PS047: SOV-112538 Parameter View...
PS047: 50V-112636_SD Terminal View...
PS147: SOV-112539

= Start of the tag name to be written

Show Connection
Alarm Limits...

[Fight-click ontag 1o getmodue 1 Point Browser.

'ﬂ Module Modes...
. <1 Tirne Series...
Module context menu available i T e
. f Additional Information
on right click on a tag name 1 o=
Trend >
[reTe @ || rroces ,
0.10 m }
% m? 1 Flow Sheet :
prm—— i List Image
L L Safety >
'WORLD CLASS — Through people, technology and dedication
S Find Tag _1o] x| For

rlagname———————]
Close
Tag: [11253 -

KONGSBERG

2
[ Match case
[ Matchwhole tag
[ Mateh iniial tag segment

| BT .
i win m i o
| 3

! !

i

T . ° o - rSelecttag HS‘
ag identification g
P5047. 50v-112534 pEuApL SN2z
PS047: 30%-112535
PS047: 30V-112536 e | ]
PS047: 30%-112537 barameter View
] ici i PS047: S0V-112538
Selected Tag is indicated by a red frame R T .
PS047: S0V-112539 i — 2
RenAT e 115830 or 1
Alarm Limits. ., i
\R\gh\-click ontag to getmodule contextme [0 Point Browser... i B
St 5 % Module Mades, ., IL'F"QZI
Time Series... | L
‘ AT | Configuration Events... L
288 m i Additional Information...
B0 m?
16052 m*
Trend

Flow Sheet
List Image:

:— - ‘ Safety
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Show Connections identification

Tool for following signals between function modules and to 10-points

WORLD CLASS ~ Through people, technology and dedication

" "

1
PS047: SOV-112533

Parameter View...

ermingl View

o
10 Point Browser. ..
Module Modes...
Time Series...

Configuration Events...
Additional Information...

Trend
Process
Flow Sheet
List Image
Safety

=  QOpened from the module context menu

KONGSBERG

] show Connection - PS047: SOV-112533

[~ Expand all

Show Connections view

u “l0-button” opens the
“lO-Terminal Block view”

%] The “arrow-buttons” shows
connections between modules by
<TagName> / <TerminalName>
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CLOSE_WLVSiut H——

Fefresh | Close |

Z0-112533 jof Inopenad

vZC-112533 jof InClosed
Remoie
Failure
Control

CantrolMade
ShutDown
Interlack
ActAlarm
Flow
Invisinle
ShutDawnEst
AutoOn
Autoof
ControlOpen
ControlClose
5015tatin
SD25tatin

DeEnergize

SOV-112533

QutOpened
QutClosed
OutRemote
OutCtriode
OutFailure
Incons
TimeOut
Errar

Cpen

Close
MaxCpTime
MaxCITime
CpenTime
CloseTime
SD2Error
SDStatError
QutTrip
Outinterlack

OpeningControl

——— C{xc-1125330ProMeas
——— f¥c-112533CIPrabeas

——— igvco-112533
iolvee-112533

Module context menu available on a right click
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Show Connections, terminal expansion

= Select || to expand a terminal with

several connections

— All connections are shown

MIC-111101

= Select El to revert the expanding

= To expand all connections for a

module: tick off the box ‘Expand

all’ in the upper left corner

WORLD CLASS ~ Through people, technology and dedication

OutRunninglLs
OutRunningHS
OutRemote

OutRunningLs

OutRunningHS
OutRemote

[¥ Expand all

-|Ballast Runicon
fBLek_cLs_vivsPmpRunning!
|MIC-111101_AUPOUtRuRNingLS
mic-111101_BTPOutRuARIngLS
=|PMP-1_OUTRUN/POURuURNinGLS
fmic-111101_INTIROURUANINgLS
|MIc-111101_STAPOURUANingLS
|mic-111101-Ricon2

[_] show Connection - PSt

KONGSBERG

Module Modes - PS091: XA-033893

[~ Disabled Alam
[~ suppressed Alam

[ Disabled Input
[~ Disabled Output
[ Pessive

[~ Sirulation Algorithrm
[~ Alternative Terminal Input

[T Suppressed Alam on Terminal
[ Inhibited Input

[~ Overridden Output

[ Maintenance

10 status:

None

Module Modes:

Exceptional modes identification

£
ok

Default colour convention for

module mode:

Disabled Input terminal

WORLD CLASS — Through people, technology and dedication

CNON N N NON

Passive Module
Inhibit

Maintenance

Suppressed Alarm (By Logic)

Disabled Output terminal

Exceptional
modes
indications.

Disabled alarm (By Operator)

Redun

OTR Cooler Leakage
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% Exceptional modes explanation
Disable alarm (DA): The reporting of alarms is disabled. Disabled alarm mode is set by

the user and acts on all alarms independent on module type. Note: Only the alarm is
“turned off”, the actual terminal value is not affected by this mode.

Suppressed alarm (SU): The mode is set by an input terminal, by the system. Whether
all alarms or only some are suppressed depend on module type. Note: Only the alarm
is “turned off”, the actual terminal value is not affected by this mode.

Disable Input/Output (DI/DO): Input/output signals on module’s terminals are frozen.
Terminal values can now be entered manually through the Terminal view.

Passive (PA): The module stopped from operating.

Simulation Algorithm (SA): The module runs and performs simulated operations for
system testing. The module takes part in simulation instead of process control.

Alternative Terminal input (Al): The module input terminal values are taken from
module output terminals instead of from the 10 terminals (provided that both types
connections exist).

WORLD CLASS ~ Through people, technology and dedication

% Exceptional modes explanation continue

KONGSBERG

Suppressed alarm on terminal (ST): Is set by the module upon predefined events. It
acts on specific alarms. The effect of this mode is that the reporting of these specific
alarms are suppressed. However, the alarms will still appear in dedicated presentations
of suppressed alarms

Inhibited Input (IN): The module output terminal values are inhibited, i.e. they are not
set to the output terminals

Overridden Output (OV): The module output terminal values are suppressed, i.e. they
are not set to the output terminals. This mode is used in the ESD.

Maintenance Mode (MNT): For loop testing purposes during commissioning. Alarms
will only appear in dedicated views.

WORLD CLASS — Through people, technology and dedication
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KONGSBERG

Module List:
Exceptional mode

= Tools » Module List

=  Multiple “Module Mode” selections
possible

= The list is static, updated on each
“Module Mode” (re-) selection

= The list can be sorted by Tag or PS
(default)

= Module description is by default selected

WORLD CLASS ~ Through people, technology and dedication

% Module List

Module Modes | 10 Status I

Wode selected modules:

Tag ‘ Status

I Descripfion

PS046: MIC-032748E DA
PS5046: TIAH-032706 DI
PS046: XA-032726 DL ST
P5091: XA-033847 DA

BBETZ NO. 2 PWD AC 4¢
BBETZ NO. 2 FwWD AC 4¢
BESTZ MO, 2 WD AC 4¢

87101 T/5 BA0WAC VFLC

rModule Modes——————————

PS091: XA-033831
Operate...

Parameter Yiew...
Terminal View...
Show Connection...
Alarm Limits.

IO Point Browser...
Module Modes...
Time Series...

Configuration Events...
Addiional Information...

Trend
Process
Flowr Sheet
List Image
Safety

[¥ (D4)  Disabled Alarm
[ (8U)  Suppressed Alam
[7 (0)  Disabled Input
[T (00)  Disabled Output
| (PA)  Passive
| (SA)  Simulation Algoritim
| (Al Alternative Terminal Input
| (5T} Suppressed Alarm on Terminal
[T (N}  Inhibited Input
[T (V) Ovenidden Outaut
[ (MNT) Maintanance
AlljNone

Sort b
’7(‘Tag @ PS

Includ:

)|

[ Module description

4 Print

| Close I

Help

Module context menu available by right click

KONGSBERG

Module List opened by icons:

T T

|Indicator fior modules with inhibited input mode|
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Module List:

Inhibit/override

¥ Module List ol x|
hochle Modes | 10 Status|
Mode selected madules
Module Modes
Tag [ Status | Desciiption -
DA)  Disabled Al
PS047: PIALTT1102 N, 5U D@y O
PS047:PICAL-111103 N, 5U [T (8U)  Suppressed Alarm
PS047: PICAL-1 11202 IN. 5U [T ©OF Disabledinput
PS047: PICAL 11203 IN, SU
PS053: HvAddgStnh N [ D0) Disabled Output
PS054: HVBddg1 Stinh N C (P4 Passive
PS055: HVCdagl Stinh N
PSS THRI FC 1L, IN [T (84  Simulation Algorithr
PS057: HVEdag1 Stinh N " (&) Alternative Terminal Input
PS056: HVFddgl Sinh N 7 (5T)  Suppressed Alam on Terminal
PS171: SW-CHC B IN
P T SWACHCRIT T [ (M) Inhibited Input
PSI71: SW-C-HCPIL. N [T (0v)  Ovenidden Output
PS171: BW-CHZE-J0T... IN
PS171:SW-CH2S L., IN I ) (ierenes
PS171: SWHC-NHZA.. N AlfNene
PS171: SWHCNHZ-A.. IN

PS171: SW-HCNHZ-A... IN
PS171: 8W-HONHZ-A . IN
PS171: SW-HCNHZ-L.. IN
PS171: SW-HCNHZ-L.. IN
PS171: SW-HCNHZ-S... IN

Sort by
’V(‘Tag @ P

ﬂﬂ ™ Module description

Print

| Close

Help |
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Module List:
10 Status

= Tools » Module List
= Multiple “10 Status” selections possible

= The list is static, updated on each
“l0O Status” (re-) selection

= The list can be sorted by Tag or PS
(default)

= Module description is by default
selected

WORLD CLASS ~ Through people, technology and dedication

% Module List

Module Modes

Selected modules

Tag Status ‘Descrlpmn - =D
PS048: HVA Com Waich 10E | [v (0E) 10Emar
PS046: WES_LAT 10E.. Lataral position
PS046: VES_LON I0E,,  Longituds postion ICI (o8) (@@
PS04E: VES_PITCH I0E.. Fitch [T (0P) 10 Passive
PS046: VES_ROLL 10E. Foll [ oMy 10 Marual
F5053: BLACKPREY_DP I0E, Blackout Pressention from DF
FS053 THR1_PowDemand  IOE. [ (OF) [10Faisate
PS053: THR1_FWRCON_NIO 10E, Analogue Messurement [T (MNT) 10 Maintenance
FS053: THRI_REDAC_NIO  I0OE. Digita! 10
P3053: THRI_RUN_NIO 10E. Digital 10 AllfNone
PS054: THR4_FowDeman
PS054: THR4 PWRCON B~ pment Sorth
PS054: THRA_REDAC NI Cperate.. [ € Tag @ PS ‘
PS0S4 THRARUN NIO [—
PS091: DCI Com Waich Parameter View. . lighe
PS091: DP_ALERT_LOGI Terminal Yigw.,, [ Module d "
PS091: THVAC ComWeteh  Show Conmection... ocule description
F5092: BOP_BEARING - Fing(+-18
FS092: BOP_RANGE Matin Ui, e fram DF—
PE052. BOF_X 1 Poinit Browser .. relative t
Ps092: BOP_Y Module Modes. relative tc
P5032: HeadingDeg Time Series. .
4 | Configuration Events.., L4
Additional Informatien...
Trard) N Print | Cloze I Help

Module context menu available by right click

Suppressed alarm

KONGSBERG
P1-015801
Acknowledge | Unit: - B51MS Contral Air Pressure
Inputvalue 000  Measurement OK %
Transformed value [ I
rAlarm/Events [FHOEES
Alarm/Limit Acknowledge | Unit 651M5 Cantral Alr Pressure
Scale high = 1063
High high = .00 Inputvalue 0.00 Measurement OK
High = 0,00 Transformed value 0.00
Low ~ 550
Low low = .00 ~AlarmfEvent:
Scale low o -0.25 Alarm fLimit Event/Limit
totn Scale high [ 1063
High high (il 0.00 el 0.00 aring 4
Suppressed it Dissbla | High r 000 ol 000 e
Inhibit | Low il 5.50 ol 550 o
| Low low = 0.00 ~ 0.00
[0zl Scale low (il -0.25 .7;‘%
| Statu: (:-,
= |tis possible to disable the S | s Enale v
suppression of an alarm from Inhit =
the extended operator menu =l

WORLD CLASS — Through people, technology and dedication
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How to force values

Mainly used for testing

= Module context menu - Module Modes

= Disable Input — OK
= Open Terminal view

= Click on the selected terminal

= Manually enter a value to the terminal

] Module Terminals - PS045: TIAH-032701

Temp-U
1

Page 1 |Page 2| Page |

Input Terminals

Oufput Terminals

HvTransfol — ~ o
Module Modes - PS045: TIAH-032701 x|

o

cancel |

Port
Tm‘m-u Tsrqu Tsrqn-W ™ Disabled Alam
[ Suppressed Alam

LN

H PSO45: TIAH-032701 | Disabled Output
0

Passive

[ Simulation Algoritm
[ Attemative Terminal Input

Parameter View.
,,,,,,,, Terrminal View.

°C | Show Connection.
Tran  larm Limits,

Vo Modes.
- Suppressed Alarm on Terminel
| Cofasstongvens [ initited Input
Addtiondl Information. [ Overridden Outout
T Trend » [ Maintenance

Frocess »

] Module Terminals - PS045: TIAH-032701

Fage 1 |Page 2| Page 3|

Input Terminals

Proleas 0.0000 o oonnan
e —— o — Proleas 100.0000
Inhibit a ilSuppress o
DisEvent o Cancel Inhibit o
Biasz 0.0000 —I DisEvent o
Interlock o Biasz 0.0000
Interlock 0
_ Transfi
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Floating Image Windo
KONGSBERG
o . i i
File > New Navigator is used for the selection of
Image Window images Type a name
m Edt Vew Modue C a 5 ﬂ New ImageWincow ﬂ
Hew Image... —
File Edt View Moddle Tools Hej N [Course] oK
New Image Window. 2 e = 1
ce Contral Cancel
Page Sety P
Pr\gt lmag'z I Productname ¥ Menubar
[ Project name. [ Toolbar
DefaLlt Printer. [ Station name I™ Horm toolbar
Toph:
O —— ™ 0S Group [ Statushar [y
Print Screen [ Operator name [¢ Alamiine
™ Window name ¥ Docknavigatar
User » ¥ Image name [ Titlebar
[~ Date andtime
Frame: [Thick =
No Image

For Help, press F1

Y

WORLD CLASS — Through people, technology and dedication

* The Image Window can be moved,
resized and minimized

* A button is added in the tool bar

mmE|E|o
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% Reminder Note

KONGSBERG

Text boxes in Process Images for important information shown in the same
image on all OS’s

Reminder note button

The heading O 03158 [~ Right click in heading
contains to get the context
information about 02031 - Operator - 11/03/2014 20:44:24 menu for changing
the maker: OS no, i FimiiEsd of layout, and to
User login and date ;M Undo Text Colour... delete note

N Background Colour...

fran| ooy TextFont... L
Right click in the Paste e i
body to get the pikr std | THeText.. {

i iy Image ...
context menu for PR seecta [ e
text changes ﬂ ‘ W W ——

WORLD CLASS ~ Through people, technology and dedication

Reminder Note — Admin tool

KONGSBERG

List of all reminder notes in the system
= Tools = Reminder Notes Manager

Operator Main

System  Panel  Help —

Browse ModLles...

Reminder Notes Manager
iEal Bl T2 Event limit exceeded
Mescage Marager button

Report Manager
Mockle Grolps..
Alarm Groups.

5031 - Cperator - oe/us/zo1s
[Mhis is a resinder note

Alarm Shetving.. B rReminder Notes Admin Tool _|=l ﬂ
Station Explorer. .
Pl e = [oamofostm [ croamdby ver ook The content (Details) of all
PFrocesslmage. Main 06/05/2014 Operator This is a reminder note . . .
10 Manager...
(o Pant Bromeer reminder notes are visible
System Report..,
Reminder Notes Manager...
[ = | 4 | ]

Fiie Sysen
Delete Refresh
185 Syriem orermien

= Click a reminder note in Image column will jump to the image where it is located
= Selected reminder notes can be deleted from this window

WORLD CLASS — Through people, technology and dedication

MAOO0105C




10 shelf

KONGSBERG

Process Bus 10 image opens the |0 image PS selection

File Edit View Modlle Operation Tool System Panel Help

T T a3
Rack1
RID Rack1
A x EY 2 a A x EY 2 a A r
= = = = = = = = =) = = =}
£y B B S £y £y B B £y £y
S} ) D 5} (5} S} o ) Qo Dy 5] e
P 7 7 ? P P 7 ® B 7 7 (S
() (2] () w w () (2] () o w () =)
o o r (%] [N o o R T [ o T
w (]
(%] R
el < < =3 e} el < < =3 e} el Lol
2 3 4 5 3 7 g 9 10 1Nl 12 13
WORLD CLASS — Through people, technology and dedication
I0 |0 Terminal Block : RMP420-32 - PS045 - |0 ﬂ
RIO
-0 E +© 10 Manager ﬁ Parameter |(Value \A
KONGSBERG = B © Default RBUS ¥ Module type |RMP420-32
o - = 045/RMP420/02 Part number
s - O 10 points Serial number
. = HWY version  |123
10 Terminal & T
X FWY A version |1024.1280.1536.2313
BIOCk 'e T (iR A FW P version [1024,1260,1535.2058
Vl W Address 2
Description ]
-
o Task: Task 2 > | [ Auto <[ [\Module info / Parameters { Cperati
i ]
Click on an 10 card and the | 2 | [No. il senzor]|En < =
= P Tt
IO T . I Bl k 2= XC-033107 |P [SIM |0 0 OK| T | CB-033106/Act Close
erminal block opens 3[=x033is [PsM |0 o 0K T | CB-033106/nClosed
4 b (033109 |P[SIM |0 o OK| T |CE-033106/Remote
+={XC-033110|P |SIM - |0 0 OK| T |CB-033110/ActOpen
G ={*CO033111|P [SIM |0 1] OK| T | CB-033110/ActClase) &
10 Point Parameters a | ||Signal Conditioning
Parameters
Basic signal/datatype for the channel DO Morm?
|O Terminal BlOCk Mode for Loop manitoring of the channel |Maonitoring
Failure value Off
Configured failure strategy Gotovall ™
<« | » <« | y
Details << | Apply | Close
WORLD CLASS — Through people, technology and dedication
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KONGSBERG

CB-033106

——— [idxc-n33106
——— iolxe-03307

ose ActOpen
Jen ActClose
Error

TimeOut

Incons

OutOpened

outclosed

Outdvailable

CBTripped

outCtrifode

OutColour

PowerDemand

I0 |0 Terminal Block : RMP420-32 - PS045

10 Terminal Block from Show Connection

Il

B + O 10 Manager 2
Bl © Default RBUS ¥
& © D45/RMP420/02
© 10 points

[145/RNP4Z0]0
[reske =] P

Tag

Description:

Task:

Parameter
Module ype

Value
RMP420-32

Par number

Serial nurnber

Hitd wersion

123

HWw type

1]

FW A version

1024.1280.1536.2313

FW/ P version

1024 1280.1536. 2056

Address

2

«[»J\Module info {Parameters £ Operati

P

33107 | P o 0 OK| T [CB-033106/ActCloze
3|=H{X-033108 |P |SiM i) 0 OK| T [CB-033106/InClosed
4 =HX-033109 [P fSIM |0 0 OK| T [CB-033106/Remote
5/ #=|XC-033110 P |SIM i) 0 OK| T [CB-033110/ActOpen
B=|XCO5311 [P [SIM |0 0 OK| T [CB-033110¢ActClose

= Selecting the 10 button connected to a terminal in the 'show connection’ view will
open the 10 Terminal Block
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KONGSBERG

10 Point Browser
from module

= Module context menu
= Select 10 Point Browser

= Shows all the 10 connections for
this module

WORLD CLASS — Through people, technology and dedication

'ﬂ'. 10 Point Browser

PS [101tag Status | Sensor |Eng. value |Connection rStation
=[P 5045 [XC-033107 | P | Siv 0 i) OK| T |CB-033106/ActClose PS045 LI
#=|P 5045 XC-033106 P [SIM |0 0 OK| T |CB-033106/ActOpen
0 K [=|PSD45(xM033108 [P [SIM |0 0 QK| T |CB-033106/nClosed T
=+|PS045 (X1-033108 | P [SiM 0 i) OK| T |CB-D33108/Remate .
! Browse Criteria:
Iy
WZA PS045: CB-033106 CE-033108
B Parameter View... [™ Match case
A . Terminal Viem. [+ Matchwhale tag
= Show Connection... [~ Match initial tag segment
Alarm Limits.
10 Status
:;; Module Modes [7 1D 0K.
| Time Series... % 10 Manual
Configuration Events... [ 10 Passive
Additional Information. [¥ 10 Eror
Trend o [ 10 FailSafe
B e » [¥ 10 Enar Override
Flow Shesat » [¥ 10 Maintenance
List Image 4
Safety L Browse by 0 Tag

AGS

Browse ky Module Tag
Details >>>
Apply

Close
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KONGSBERG

10 Point Browser to 10 Block view

Right-click on a line in the 10 Point Browser

*, 10 Point Browser

S

Ps_[10tag Status [Sensor [Eng. value [Connection Stgion———————
033107 [P|SIM__ 0] 1 OK|T[CB-033106/Ac(Close. |
[=[Psods caozaie[B[s (o] o)\ [oK pen
BlsM [ 0 OK|T | CB033106/nClosed
P [Tag

Show C20Tag
Add Trend to previous popUp
Create Trend n new popLp.
SetManual Valle,

10 |0 Terminal Block : RIMP420-32 - PSO45

NEE

40 0 Manager 2
& © DefaultRBUS
B © 045/RMP420)

© [0points.

Teg [ods7RMPA20/02
Descrption

Module type |RMP420:52
Part nurmber
Serial nurmber |

W version 123

ype |
FW A version [1024,1280.1536.2313
FW P version [1024,1250.1536,2056
Addiess 2

Show IO Block. ‘

" -
SetEror Override ] Tesk: [Toskz2 | @A <[> [\Module info {Parameters { Operati
Set Simator Off
SetIo poirt: !
SR AR S Wo.| [101ag | [Statws [Senser [Eng. valus [Conmoction T =
Te]coTs B[S o] [o] [T FE0a3105/AcORen |

) 2[=lrcamio7[B[sm (o] o OK| T |CB-033106/ActClose|
Correctons 3 =[X035108 [P[sM (o] 0] |OK[T|CB03108/nclosed
Auto Connect 033109 [
Auto Corect Al 5l=[xC033110P[SM_ (0| 0| K| T|CBO33 10/ActOpent

L. slelComti[PlsM o] [0l |OK|T|CB083 i0/AciClose 2

Signdl Condtioning.

Create 10 Port Tyy
Select 10 Point Typical,

#ioTeg

[10 Point Parameters

[Signal Conditioning

Parameters

[Basic. Tor the channel DI Normal

dule Tag

[Mode for Loop manitring of the channel |OF
Tirne-tagging of digital input o

Select Show 10 Block opens the actual |10
Terminal Block view
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Exercises:
KONGSBERG
= Basic Use
=  Show Connections
= Floating Image Window
= Reminder Note
= Module Modes
= |0
SBERG PR RY -S tatem: 26
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prietary informatior
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KONGSBERG

Learning Objectives

Use the Find Tag function

Identify and explain the Show Connection view
Use of the Show Connection functionality

Identify tags in exceptional modes

Identify and explain the Module Modes dialog box
Be able to force a value by disable terminals
Identify and explain the Module List dialog box
Carry out selections in Module List

Identify and explain the Floating Image tool

Make, adjust and reuse a Floating Image

Identify and explain the Reminder note tool

Make and adjust a Reminder note

Identify and delete Reminder notes from the Admin tool
Identify and explain the I0 images

WORLD CLASS ~ Through people, technology and dedication
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End of the
presentation

ent of Proprietary information




